sl BGuAlol
53] A2 AciAlged] 212Ul

HFLE Yol A6 wel eyquydl dsiudz wol Wil eusl 6id 8, d Rasasl aquasd R0
Heedu oA O, AdA Rsud, Galeddl dwemi A e ool Avani wusfani A Hesy
ol B, defl ¥, delderl /AL A% ARy @R AN 2l du d w3El 8, Bl AR Aead
vl yausidlell Aadl 4F A GRdd gl wil

deiude W ARRe dg 2 uRR Addal Aol aHs B. AUuRd (interactive), Guaosdl w2 s
(user friendly) dan AU (accurate) ¢ GUAL] WRA Huadl Asude siiadl 2 usRY+s s1d
B, dnudedl @t Adl el ASA, ¥l Guddtsdldl A WRAMe @Bl dul Gualdisdl dlRar d-l
Hasld 4. o W2 Nl U, dl d ueAl vl awd s3. deudedl |Hl Kl aud Wd
U Bl wid, dl vl &g Rig 48 ad du sl douided 2wl Sl W2 BUAND AvdlAL
arte el 2l sl wdl . wud s0R (KompoZer) sl deeell deiude siendl
dl 232 W wslfid (publish) sy

dsudes) »udy-L (Planning for the Website)

Wl doiudedl Qs 2w S5 yeL et el Fol ¥ s Dol & uA del W2 Ragd 2wy, 37 8.
w1yl B2g tddr ¢, dnwse-l GuilRidi-il deol Agnci-l ds ut deell o ay WA, slln wsell sdlw
dl dsiude siildel Wt Wy Rg 3 wsd. wd dsRude sriaa AR el WEwn sy
Uvial el d2es vdll el (1 sulen S :

&g (Purpose)

deiRuedl dq wWenA Awvifd wdel i d w3 . dsutedl @A sl udal d-dl ey v
By @ dai w3dl 8. oy Ad @i wddl dsrude A Heegd o 8, dsiudedl WAl ¢
Gl ayen WRA Yl uard, dal wehd wwsialdl 3 Galedd idaidd daaidl QS ud,
dg w48l aw ugll deiuset [@Avuary (content) A Juwi (layout)d dou Ad [Asudl sy,

Rasel (Audience)

dsiRuenl Jrlens Rewdl s 93 sl udai WAAd Gualdsdl 23] Mewndl ddl w3l 8, dnwudeni
WA uA Qg (detailed) W el s+l HRAL dldl AS2. dxi AR nA wx URAA wwda
Rl gl ddl AU RA QRY UHR, BRAR w QRANAL oludl R AR Yasdl 3@
Yy Wdl 8. Aoz Ul Gudloisdll wAma) Anadl ¥3A B, LW d Nesdl Asde-n Wy
RQuuag 2 udviil Rsmnl Hee3w oid 8 v dnude Guddll dul ¥sen @l vuadl 2l 8.

Wk Yy WA YAl dids sioid O GudLsdivl dreniz Aamell aeu, Al derude wR QA Roliois
sldd)l v 2wl &y, dl A G nami ais) wHu A B, J2dls ar Gudduql wdl Rwun
sl As Al AR adl Wz Gl & Ad ue @, W2, douderl ozdl du dear wwewi
o @ ud w@Ru sddadl wuda Al wd d Susdly B,

52 SUY2I- WY ¢ 12



[@Nuqrg (Content)

Asrudedl Ayel 2 Yd WRAL Al vicia 3 B, wiod WRAA ay Gualal Guddisall Frua
orudl 93 &, 23 A W [ Urd s wsdl Al ael, A yIl uani 2wl Rl wyd
da, dl Gwidoisdl dsrude Gl e uF B, W A Yaidld WRAL sl Guldigald AdN wnd
a8 aw dsudai A« W wnud W B, derudedt Fuaga wru-d . Agd 9ol adag
%33] B,

A @Awudag Gualotsal e wee, Ay, Galed d A dal A dgalld Rdouadisn
(overview) yi W &. R A augdl Gwiloisdl-l dual neezu A B, A Qou wd wee
Aol Ffu 2 B dul wdei wdd - Guasy axgal Wl mesd yil ud 8,

Ragd [Anuazg Gualolsdll Gauled sl A 2P0 Rigd MR Yl ud 8. dsiusedl guive A
Al ASA 3 Gudolsal Al Gudel Al RRre WRA Wwadel Aadl ul.

vl §5U dRAL Aoy deuS- AnA AW, Aoy wR QAye wuenl @Buadeg salaad du dl
Al bRl Al Ul Reusdl addll ugd RS, 20 sae] Gudosdl Ddid %33 uRdl aedel
Aadl 4 8. dsudedl ARSU (navigation) wsy ¥ed A dld ASH. s well wl By WAl
W AAidRe WA dlg AN, el Gualolgedll voR W 3 A sul B A iy W 3 Ad wl
&3l usial

A B QARRe AH oA wsRdl w3 WRA WRadifl Guasy s, dl o dsuderd]l @Al Giay
W2 W3 B, WA Ruudagell Ao douide Gela 3 uiwd v w2 s Budl wyq ol 8 8. ey
AUAAl FH deiude wa W w2 A a3 4k B,

Wy (Medium)

a4 A aYy cilsdull ¢d BuA A 20d2 g Sr2vnedl Gulal s W B. Asudel Fudvueg se
Sa423 PR A 26d2 Fal dHM AN 3w g A, 3w Guria dsiRudedl Fuvu qur
Rl auid 3 e wAdl Ak AT d Bl S, S0, WA WA e WsRARR
Fdl adid HARid AseuBoRui oy A eulaadl »ud.

sl Guala 53 uxn AvS2 si-uadl (Creating a Simple Website Using KompoZer)

AUGHL WsReMl YRl SRl Heedl Aol W@e dul AMIE W2 M B Gyl QA vl
s odl dsude tiuaal 12 WL A wddl daldl Hervdl Hel And odl gdl gd 2l SR
qeedl s AUl S-gial-l doude 3dl Ad orudl wsny, A viewd s

2148l "School Plaza" sl As A $-s13d dmauderl a-u 3R, ¥ awonai vl Renei- w3Rudl
Wil sl d e AsiRude v yas, Raqdl, wondl so, welldl slizd, ARl oo, gda, ek
el deil Fell wond AsiRd wey dagel Guact ¢d A d«dl AR ua Wl wnd. wnd s WhioL-
g2l ue 2anl Ay, ¥ wdeanl wddl awm axgaldl wel A ga . eulad. wvd -
KRl dnude] ey A AP 2eua wigl 3.1 i 3240 ealed 8.
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School Plaza

One atep for all school necessities

Calegories

New Products

School Bags
Water Botthe

Girls Pink Bag
s, 30
¥ Add to cart

1 Cuantity

Boy's Blus Bag
R 410
& Add to cart

A ___ | Quonuy

e Poncl] Bax
Hs, 50{sat of 3} Colg: P}gc:b R 80
Add to cart Kb 5 Gt Add to cart
1 Quantity 3 Quantiry 1 Duantity
—
ri
(7 |
Angry Birds Lunch Box Cartoon Lupeh Box Eraser
As. 110 Rs. 120 s 540 ised of 4)
Add to cart Add to cart Add to cart
1 Quantity [ Quantity 1 Quantity
[
purchane
Abusst ool Sim Map Frellack Contues L

Lopyright © 20132015 Schoal Plazs. Al rghls resanost.

sugld 3.1 : dsiuded Sy

el - mozflla Firefox
Bl
& filejifmediafwebsite/school-plaza/billhtml

Categories
School Bags
Welcome To Billing
Water Bottle
ipti Price Quantity Total

Lunch Box |Girls pink bag 359 [2 ]

Boy's Blue bag [410 2 {820
Compass Box [Total 4 1618
Slationary

S Prodeed La Checkaut

Eiles n Folders
Books

wgl 32 : ailiasd
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2R 5BLs uatdl g1l w1 Asidedl e 530, wWluan el dsiRued e sisillyl, weud Guadoisdl

QoG- JusRML URL uey GAY, i dsrudert wleadmi swadi Ased wead Quly
58 8. Q@ Guasy axgal-l adl (Category)fl wiél wuuell dsrude-dt dxloril suladl AdH.

AS wel a3l W Fus seanll @ adlii vuddl axuil eufag v Aol 3 snni wad, dsude
sirildal W2 2»d2 (Template) N evudl REY 3uAvuaddl @y Sweade wR Fuyes Guasy 8,
A 2udz Aol G s3I W3R s Gudldil 4 sy 8.

Quiarefl W@ gL doiudedl Avd Al W2 SR vldl Ad deiler eidl dsidasi dum
Rrzazg 2 Fedsd olsar a2 wugli 3.340 ealon 3ot A v (cell) wRag shes G,
fres GRar W2 Insert > Table yde 5 s Ad 4Uad Sres wie A OK o W
(as s

m Insert Table Ox
| Quickly | Precisely I Cell]
N

1Xx1

Advanced Edit...

Cancel OK

wugld 33 ¢ 1 x 1 Ses G

Qoy ofils il Qe g s My AeslGorRul adeasuil sulddii wuad. wudl, 2
"School Plaza" s v 8. "index.html" U sl #ida-dl e sA. WA A dudyq
index.html «w3 duari 2ud B, dsdl W eis deRude Rise sldlccmi 2wd & wd els
Qo ¥ Anudy ursll ada f19d B, wdd Gudawdl www.schoolplaza.com %q dsiuded A
URL ouGui avl 8, i} d vladidi 2iadir sida-dl wwedl sRd «dl, wig deudad d)
Auuazq ealaar w2 As ydRulRd sidedl o3 W 8. 3 ydFulRa #1daq - index.html .
AW, U sidadl a9k URL Gladd 2ud 8, i ud: ydMuiRd sudan euqul af dd
sy sald 8.

€q, 28 GRIaL Shesd olsgules saR ulyl shes ude sl ma (B s dsfAs U shes WR
ude [Rus s3] 'Table Cell Properties' Rsew wie s3] any. 2w saell 2ugld 3.4%0 ealdd Table

Properties Sludloisiisy vad,

sl GuAlal sA an Amadadl W@ 55



'm Table Properties

Ox

Table | Cells
Size
Rows: g Height:
Columns:; |1 Width:

Borders and Spacing -

Table Alignment: | Left

Background Color:

100

Border: 1 pixels
Spacing: | 2 pixels between cells
Padding: 2

pixels between cell border and content

(Let page color show through)

% of window =

% of window =

Caption:  MNone

Advanced Edit...

Help Apply

Cancel OK

2usld 3.4 : Table

Properties Siuelaolisu

[ 'Table' 217 'Cells' & [AeuoL (Tab) Al 4N, F-U gL Gudldisdl Sives ¥ ada Aa-i RRY Wi
FEbBld 59 asdl. Shes AeiBd A 2wl AS usdl. Table Rowddl 2wwden Rsey 1A salon S

1.

ud udons Rsd vigql B 2s-1 @3l S wd.

Size : d ¢dA (Tow) ¥ ™ (column)l Avul del Svesl G 2w ydus euld 8. GRus

Borders and Spacing : Avesa Abulvil (border) el €, db & W2t Rser wdl eafaqmi

wid B, Ad aRdl ooyl Ffad sRdal W2 spacingl Gualal KAl wwd 8. Aadl Bl w4
dul 2ida auiel a2l ooyl A sl padding-) Gualal saumi wd B,

5. Background Color : Slesvl 8156wl

Table Alignment : ses ol ouy, ol suy 3 qal oled .
Caption : %32 wuy, dl Qs olls vl wsy B,

sa3 eauld 8,

wugla 3540 ealon yast dwidl S Yl Sls3uGw @R wde s

[m[Table Background Color

m

Hue: 0 4 Red: 204
Saturation: 0 % Green: 204
Brightness: | 204 3 Blue: | 204

Predefined colors:

=E Last-picked color
ﬁ Hex: #CCCCCC
S| Name:
3 | Transparent
Cancel OK

sgld 3.5 : Table Background Color Sueldilsu
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¢d, "School Plaza" exial 2 dnl Asid Rol GARAL W2 dls AN A 6 G YA w= LS
GATRL. A4 e @vun eufad wA ollwni Rol enfadmi g, Insert = Table Rsey wie s
syl 3.6 ewlen s 1 x 2 fres wie s A OK sl2d w2 (s &,

| m Insert Table m

Quickly | precisely | cell ]

1x2

Advanced Edit...

Cancel OK

ausld 3.6 : 1x2 Shes BArg

shesd SLs3UG-d SR UL 8d A sl suyeil AUl avun i wHell suyl Aaui Fat GALR,
oL Gl W2 Insert > Image [Qsey wale s dsf@s Ad, 2asu: W sudal Bo-il sust W
Gas w53 wsa 2n el sugl 3.740 eulda qudoolsy vlaani siad. Reg - dd
gy ollsunl As[@s @uud GAA wA A dsfAs auua Gl Aidldl - &), dl "Don't use alternate
text" AR ol uale s AR ouGoRd suldl wsiy dd A M, MR Al @A 2w As(As quel
galaant wuad.

|- Image Properties

| Location I Dimensions IAppearance I Link |

Image Location:

file:///home/Desktop/schooll.jpg

W

Tooltip:

@® Alternate text:

Don't use alternate text

Image Preview

~ Actual Size:
% width: 262
A Height: 192

Advanced Edit...

Help Cancel OK

w5 3.7 : Image Properties Suelowlisy

A4 : 3uuR w1l schooll.jpg Riatl Gudlol sul 8. Rene(f)l Wl wiieslld R oeudl 13 & viyal
e Wwde ol Gudla 3 Wl B,
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¢9, Dimension [@eilol uiie 53 A4l sida Custom Size [Qsey wde 5 Rl sy Aaul sulaa
Qaell wugl 3.840 snlen yast Qs A s 100% vy, w-u Aasi gl 3.940 eulen
Yael @uuel GARL

'm Image Properties Ox

[ Location I Dimensions l Appearance I Link ]

Actual Size
@® custom Size

width: | 25 % of cell

Height: 1100 | |% ofcell 2

Image Preview

Actual Size:
o, width: 262
R Height: 192

Advanced Edit...

Help Cancel OK

2l 3.8 : Image Properties jndowiisuvi Dimensions [oua
3y 3.94 GRami wda avie wd Ao sulai 8.

Schoolplaza [File:/.-.findexhtmi] - KompoZer

File Edit View [nsert Format Table Tools Help
= .14 Q@ K G - L& ¢

(= Opas Butiah  Brrww Unao Anchar L Dmage Table Fare =

Body Text = = &Y nE e = = 3

B wn|lBI1 U

* Site Manager schoolplaza

View: | Allfiles 3 ]
o W =& 119
Name =]

&

FTP console * é &
* DOM Explorer = Design | % Split | 4 source| Narmal
<himls <body» <foler <thody> <liz «<td»

2uld 3.9 : Ra 2 avum WA e

¢q, @dll (Categories) 7 <al G-l (New Products) saladl a2 2 ¢dm v 2 del 4alag 24
sy GG uad gAaL Al "Categories” ¥ "New Products" awiel 28w L Format -
Text colorl Gudlal &3l avied Wy 30 2dl gl 3,104 v Wil ¢Aa euld 8,
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Scheolplaza [Fite:/findex.html] - KompoZer

File Edit View Insert Format TYable Tools Help
. = @ & W - T
Opan  Lew Publih Bemwse  Und Ancher  tink b Tats  Form

Body Text 2= gt RlEE | Ea|E =

ks |lerg|B1 WEEIR

variable width

= Site Manager B5choalplaza I

<htmi= <badys <labies <tbodys <G> «dr <tabler <bodys <z <td>

Wiew: | Allfiles = I 17900 ] 1
Z = 8 -
Hame lﬂ|
— P = a =
& Categoﬁr‘}les New Products
: :
" 1
i 1
i 1
" 1
" 1
i L}
FIF console " '
i i
n L}
] ] of
2 1
* DOM Explarer ® Desn]n["’h splic | 4 Source | Normal

augld 3.10 : dresdl ¢Amul Gl da awum

AR ud, oll® ¢Aaui categoriesll flA s wM WA ay gAA WA Vs WA shes GAY, 3
sresil agadol, welsll olled A U arg WL g3 ol Ass Aol AN avimA Doy
3w, Wl ol 2l wiar W2 2wl wd A ue G wd A GlRa w2 Insert >
Horizontal line Rseurl GuAaL sai 2ud B, adfl, adlid Adl Fd Ris wunanii i€ ¥ & wuvas
Wit 3¢ k-l AR Wl w2 @ 2 @0l u-ll @y Hund uedlell si-udlyl. € WUR A BlgnAl
Aarll A dagell ol 27 A iR @A GlRaAL Sresel 2l SR wiini sufaal S Qi
d g MR Aves GAIL il 20U 3 ¢AA WA 3 ot WA Sres GAY B, delai GG Sres

gl 3,114 sule 8,

Schoolplaza [file:/.. findexhtml] - KempoZer

File Edit View Inserit Format Table Tools Help

<html> <body» <tobler <lbody> <tr> <ids <tobies <tbodys <trs <tds

= _ [ @ I 0 o U7
Body Text zl (= IR R A=A & ik & @
B s BI U
- Site Manager schoalplaza | e
View: | Al files >~ ] 119px ] T3 |
5 ot ® ] |
Name lﬂl
—| P - o o
#|| | Categories New Products
- R Lo
School Bags
Water Bottles
Lunch Box
Compass Box
Stationary
Files n Felders
b ol
FTF console B
+ DOM Explorer = Design | = spiie 1% S-nun.e_F Hormal

gl 3.11 : widl wd culadl 24

SR Budal 53w Astaudedl
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.

AR ole, wri-l (1AL oLl "About school plaza”, "Feedback", "Contact us" i "Site map"-(l
Qo w2 viru s shes G sresell Wil A @ud GAAL L awum il [y ondl,

WA @oleia 2] Ay oi-udl dlf 8. aul SS umt adl ur By U wad @, wHi-l slsaw
A W4, uig A @l wqIu B el ol 2, ¢ aal Aol R sl gz Al uig
Qularefl o sell ay «sel &3 AR Horsl Adl R &3 usd,

Save As [sen ude s3I sidadl gei-gel gl s 5L vl s1dadl ANS waterbottles.html,
school-bags.html 17 lucnchbox.html «it® W& s2cmi 2ual 8. ¢d sl Alad AS adl Rs w=
(Rs sl g, AR A Aifd dsily wadl, dil W buqul iy gl 3 oi-uddl dam dsiam daly
%q o ds wig B, As wel Vg Aoy Wil wd Format > Page Title wA, Properties [Rseurl
Gualal &9l eds deilaq uflds sledl ¢, els dolor il Al @dld urqau @ G deilosi
R G-l ugldl u-uciel 2y awd aslond yal Rel GAL amal

Qudani arqaildi Bol v defl Bod) GRadi udal yelyger adl w2 Risdl 2 sdal, aslqi «m
i By sl dnl deifid deldy vl

index.html s1del vldl (sl -l s W2 avilgl (School-Bags) 4rie $A uiel Insert = Link
Rser wale s d »ugl 3.1240 ealon yusid qudlowlisy Y sW. Link Location Rser dsu, %
s18a vlaasl 8, A euldl (school-bags.html). OK o2t w2 (55 AL,

{m|Link Properties A A o T
Link Text
School Bags
Link Location
Enter a web page location, a local file, an email address, or select a Mamed

Anchor or Heading from the popup list:

%

The above is an email address
B URL is relative to page location
Target
& Link is to be opened

insame window, without framesets =
~More Properties

Advanced Edit...

Help Cancel OK

WA 3.12 : Link Properties Siuelowiisa

gd, Ul Adl Galerdldl [Aodl G, shes 35 Aadl ayge Ra, axgd un, Bid da Add
to Cart Azl WA drgel e R sReolisd GAANY. 2906 Gualai el ueld Harst Rt GARL
Gedlgrid, UM A Fud G ¢, sbiFes gl As Asellsn GAA Asollsn 32 bl -wall "id" HTML
Alfisdl GAFLY, ¥l uelel il Gualal sl wad. "Add to cart" A Aot GAL ulel,
wzsladl Fad 1w "ql" id Wl 2sesllsu G "Quantity” ded 6. wwl Gudisal Add to
Cart AsollsA e 50, UL arg 2 d-l el AR S84 Wade s wdd, Gl 2wwdd
Gulerll [Roldl sugfa 3.1340 ealdl 8.
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Schoolplaza [file:/... findex.html] - KompoZer

File Edit View Insert Format Table Tools Help
- e B L ORES L8 *F
Body Text = = | = = | 'R = 3 L]
variablewigth = |lF» & KB 1 U E E 3 B
~ Site Manager schoalplaza ] ®
View:  Allfiles 3 [ 1000px |
W a3 R = @ Ldteguorics NEW Froaucts
Name Je]
School Bags

Water Bottle

Lunch Box

Compass Box

Stationary

Girls Pink Bag Boy's Blue Bag Bheem bag
Rs. 399 Rs. 410 Rs. 500
Files n Folders [ Add to cart [~ Add to cart [~ Add to cart
Books 0 Quantity 1 Quantity [ Quantity
Colors
FTP console
+ DOM Explarer = 0?1'9"[55 split | source| Normal

<html> <body»

25l 3,13 : Gened WA Radl

A4 @ AW ouda ol WAl @l dedo G el RQANAAL B WA (. wy dolly
guladmi el el

wirtivit fld-i cudi "Purchase” olet GARlY, % 2uved BGiad]l Radi-u d8U drg ad @l »u ws
vidlsaini widd ga aqaildl Aval A ga WA eald 8. sedsll onclick gzql AHA A8 RIREL 3.1
gulde Aal@e GAN. d oncart() AAY) »Ha 520 w AR ul oncart() RAY (Bia W2+ Andy
gafadl,

<script>

function oncart()

{

var check=false;
var cookievalue="";

if{document.getElementByld("bl ").checked)

{

check=true;

var quantity=document.getElementByld("q1").value;

var price = 399;

var total<(price*quantity);

cookievalue+=":Girls pink bag,"+ price + "," + quantity + "," + total,
}

if{document getElementByld("b2").checked)
{

UMD GualoL 33 A Asude-l w-u 61
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check=true;

var quantity=document.getElementByld("q2").value;

var price = 410;

var total<(price*quantity);

cookievaluet+=":Boy's Blue bag,"+ price + "," + quantity + "," + total;
}

ifldocument.getElementByld("b3").checked)

{

check=true;

var quantity=document.getElementByld("q3").value;

var price=500;

var total=(500*quantity);

cookievaluet+=":Bheem bag,"+ price + "," + quantity + "," + total;
}

if{document.getElementByld("nb1").checked)

{

check=true;

var quantity=document.getElementByld("q4").value;
var total=(50*quantity);
cookievalue+=":NoteBook (set of 3),"+total,

}

if{document.getElementById("cpl").checked)

{

check=true;

var quantity=document.getElementByld("q5").value;
var total=(45*quantity);

cookievalue+=":Color pencils,"+total;

}

if{document. getElementByld(“p1").checked)

{

check=true;

var quantity=document.getElementByld("“q6").value;
var total=(80*quantity);

cookievalue+=":Pencil Box,"+total;

}

ifldocument.getElementById("11").checked)
{
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check=true;
var quantity=document.getElementByld("q7").value;
var total=(110*quantity);
cookievalue+=":Angry Bird Lunch box,"+total;
}
if{document.getElementByld("12").checked)
{
check=true;
var quantity=document.getElementByld("q8").value;
var total=(120*quantity);
cookievaluet+=":cartoon lunch box,"ttotal;
H
if{ldocument.getElementByld("e1").checked)
{
check=true;
var quantity=document.getElementByld("'q9").value;
var total=(50*quantity);
cookievalue+=":Eraser (set of 4),"+total;
}
if{1check)
{
alert("No item selected");
}
else
{
document.cookie=cookicvalue;
windowlocation="bill html";
}
}
</script>

sfalEa 3.1 : awmda w2l nalke

W 3,140 oncart) A4 eulef B, yun if R And & 3 iteml wq Aselis
Wie sl wel 8 3 Adl w wdal A itemldl Asolisud "b1" ewnell id www 8.
document.getElementById("b1").checked [@tu-i-il Gwallal 53l dwaiciil 2ef 8 3 Gualoisdlal daq,
wie A B ¥ Adl A axg wie sl 2udl i, dl del ool ygul wadl ga Wil arddl sl
wlafl. iddl, Rl W@ A U, Baud, ol 2 gd WAl Agni U sy wdl eds [QdldA
weRAA () a 9wl 2l B, els Gauenrdll Roldd Rasl (1) g 9 Wi 2
8. Wl ddd 835 dig W2 /R ddn audari wd 8,

SR Gudlal 9wt dmwdedl 2w 63



A Gulatsdldl As u arg ke 53 A & WA purchase sl W Bs Kail 3w, dl "No item
is selected” avu@t A Az euldadini wad. Adl d, gl ‘48’ (cookie) diy Ungani 2.
Guadlatseinil sHwiel ARG s uddl e ‘g8 53 B, A ol we Wl yausidl-l ay Wl wdeiq
W2 wgal wderl wisgRnus WRAL w2 w3l wiedllal, wA€l, and vid Wy wRA yi wl
8. Mmafeni document ulioFserdl Cookies @iyl gl g4l Gualal &3l sy B. g4 airll asy
8, Wl wsn B, Yl wsu B aul 22 KA A B,

o3 Gulolsal Purchase st W2 (Bus 53 8, R w32 g "billhtml" uid eulaami »ud 8.
bilLhtml uiridi MURPS gl vde 36 ARG W2 4o argul-l dval WA Yl go Wl ariddl
sl 2d 8. ga Wl o] KA Wl maBe SR 3240 saldl 8.

Wl myfun() - RAY crvuRd Rl el 8. 2 RAY 44l WA Radl 4 A 230 Aadla
£ 8, &R usl R parseFloat() RAu gl A &l WAl Rl wd &, 2idul WA
gulaqni 2d 8.

function myfun()

{

var cookiearr=new Array(};

cookiearr=document.cookie.split(":");

document.writeln("<center><h1>Welcome To Billing</h1></center>");
document.write("<center><table
border=3><thead><tr><th>Description</th><th>Price</th><th>Quantity</th><th>Total</th></tr></
thead>");

var total2=0;

var total3=0;

for(vari=1;iccookiearr.length;i++)

{

var cookiedata=cookiearr{i].split(","};
document.writeln{"<tr><td>"+cookiedata[ 0] +"</td><td>"+cookiedata[ 1| +"</td><td>"+cookiedata| 2]
+'</td><td>"+cookiedata]3)+"</td></tr>");

total2+=parseFloat{cookiedata[2]);
total3+=parseFloat(cookiedata[3]);

}

document.write("<tr><td>Total</td><td>"+""
+"'<ftd><td>"+total 2+ '<ftd><td>"+total3+"</td></tr>");
document.write("</tbody></table></center>");

}

</script>

adfaREn 32 : ga ww v wdl nal@e

vidui, Guddisdl Bierdl duldy u udal Proceed to Checkout sleri w2 (Fus 8. 2 a4 A
Gualatsdln -8 53¢ dl i, dl A A RA YAl wad A A Guatsdl-l <lluell wde -
Y, dl A «d wid (account) olrliqdl W2 sdal 2iad, 2 WS RLAAL wsEHl Al ) A Yo
«lugll v $i (Registration form) oivlidl usiy 8. R uedl Al s g 8l sami wda
ysaeli-l Radl GIR] asi ws-y Ad, 2 wsrl dsiRudedl edqaiud H2 aslal W@ sau-l
o3 W B, UL Gled, el adal Guoisdlxl, @RS Ad, waad A ey iR Roldled
UL seunl el &y 8.
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duade usifla sl (Publishing a Website)

iR Yl wnd sl deeel wa dsrudedl @Al RA hul, ¢d Aerue 3dl A welld
(publish) Rl A ASA. dsiuded Nelld 3 nsfd sl A2 3 Guaosal wedl Aoy, R 1A
euddafle-l Guadol £ 92 A A2 A dsudR w2 WAl @ wBuA AL Ad ‘R (Uploading)
> Wamami wd 8,

A deudl uR wugl vig &Y, dl dsiRuded wuald s usu B, drerdedl Aal YA weR el
(Internet Service Provider - ISP) doiud: u #alRd 2oul yil uld 8. cnauls dd dR3a 43
widl dzened WAl wow wIlEl ua asi B, As@s dd, dsiuded uudls s W2 ggu dadle
(web host) 8, ¥ Guddisdll wallRd wow Feges Y W B, 2 Fuyes wow 3uiRa Anamylel
w2 wat @Y ud 8. WU sirudd deaudedl Gewsaul wdl ¥ Fuges ool Yy widl wdedl Gualal
sA dsude wudls 53 B, wded ella sl Riredsll slsqell w2 o ¥ownl ARs wmal ¥3d
8. index.html Aeider ulle) A File > Publish Rsey ude s\ 2wsfa 3.14 sulew yas Publish
Page udldlellsy % S04l 2udd,

[mPublish Page ox|

|Publish| Settings |

Site Name:  schoolplaza

web Site Information
HTTP address of your homepage {(e.g.: "http://www.myisp.com/myusername’):

http://schoolplaza.t15.0rg/

Publishing Server
Publishing address (e.g.: 'ftp://ftp.myisp.com/myusername’):

ftp://ftp.schoolplaza.t15.org/ Select directory
User name: u632897596
Password: s i Save Password

Help Cancel Publish

R 3.14 : Publish Page Sudlowiisa

Publish Page studldellsudi 2le dsame Qowodi Al Rowdl Yl wsani 2ud 8 :

1. Site name Betii dsuded wm GAA dsudedl qeel AMadl W2 3 Awndl GuadPL HUR
(KompoZer) gl ol uidRs dg 32 sl wwd 8.

2. Website information®i "HTTP address of your homepage" [Bes doiuder Wial AW nyal
URL ¥ &3 8.
Al Bl deeanz YR QRS luell sudl adlA gl $e2anz uR Adl uell dsude Guasy
8, -l ueeell 2y QNS -l Aluell s wflA ol G dfld, Awsu-u vl Ysd
www.schoolplaza.com %4 -3 dudl sy 8.

3. eoul wledni 2idl QA ISP ¥ Asidee g Aside welld s 2 Radl YA wiusi »ud
8. usu g e AU R A FIP gl AR KR e €, di FTP ar-uy ady
S MINRLL s Y] doldlR2 U §ldal-l @Aid® W2 File Transfer Protocol (FTP)«) Guylol

Rl Gualdl 54 A Asude-l w-u 65



A wd B, UG 3l s A yarel, v WBWA AR 3 us (publishing) & B. FTP
YoM 2 wual 2l

A4 dedre gl Y wieani 2wddl Ry woudl Rad wsl 3.1440 eauldl 8.
syl 3.1440 wudel Publish Roeua w2 BFas R 2w seudl vugla 3.1540 eulde Quelawiisy 21

ud.
fm|Publish Page Ox
Site Name: | schoolplaza > New Site
Page Title: | index e.g.: "My Web Page”
Filename: | index.html e.g,: "mypage.htm!”

Site subdirectory for this page:

& \Include images and other files

® use same location as page
Use this site subdirectory:

v

Help Cancel Publish

sl 3.15 : Publish Page swelowpiisu-l Publish Reus

¢d, 1A culda wadid A :

1. 9 wie add 4 &, dl Quilbd Aquidl wded un wie s

2. Page Title GY3), d index.html-u alds-D deal »ud B.

3. g1day wn 2l 2l index.html #1894 vdel Qaid sRA d 2w sida U @ A,
4. 9 Aoy Wderl Vel Risedni &g #3dl €, dl A4 "Site subdirectory” Resui G Jeells
die Al W w3Rud YU B ¥ delyl public html ¥l @dal RIsesl wmanl 214,
Rl w2l Risedl Flud s wmied fd Rold d o Rseddi wvicusi »id &,

6. Publish 62 w2 (a5 s s 3.1641 eulda Publishing gudloeilsy 2% samii wnad,

| m Publishing: index m

b

Publishing to Site: schoolplaza

Site URL:
ftp://fep.schoolplaza.t15.0rg/

Publishing Status
Publishing...

I index.html

| Keep this window open after publishing is complete.

Cancel

g 3.16 : Publishing Sdlaovisu
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¢d $oR (KompoZer) sl 2udls 9 . vidyl Pop-up A2 uelld 59 wud\Ror 4 s
ollg, 8GRl URL asu s30 dsauden qurll 4l

AR WAL 22 wuAAd 261 (Other Open Source Web Development Tools)

sl needl dsuderdl - 2dl WAdyds 53 sy, Al WD ewR sl WU WUE AY
d oo saloR 3 detEs HRY s [Figes 2 wliudRbAiRl IDE 8. sl 39 o ds@si R+l
gell (uges 260 de2ar2 W Guas 9,

"2 4R ARl Guast @u A A8 Jaad gl dsiusel Qs M2 aradiEl Gualai as asiy
dal 3zais vl g QA Al s

a2t 23R4 (Aptana Studio)

AsiAAEoL sirilaal W2 2eie R s ugy il IDE (Integrated Development Environment)
d. & HTML, CSS, JavaScript, Ruby, Rails, PHP, Python A <y g2ll ciruaidd adedd g
As Ayel AsRsY WG AR Y ud B, A RBya dwwni aqidl wW@a-dd Wl adpyg
A B, }Weldl RRA 2.0.5 (F weri RRA 2 ua sdan D)l Gud. HTML, CSS i
JavaScriptl eedfl deRMULIAU Qs 2wy O, www.aptana.com deilide uel d WAde
Q6 A wny B, waldl RN g wgl 3.1740 ewled B, sugladi ealen yas Al
ueedfl PHP, Rails, Ruby 3 Webdi 3\¥s2 oivlicll 51y 8. vl $v2834l evle HTML 88 2usla 3.184
salda B,

Aptana Studio 3

s & By O v+ |IB5 O B o B [aweb

-~ Select a wizard

Wizards
et - A—— B — e

There are no projects in your |
workspace. To get started,

;uleasecreateanewprojectur & PHP Project
import an existing one. & rails Project
{: Ruby Project
@ Web Project
¥ = General
¥ = PyDev
* = Ruby
» = web
¥ (= Other
? Cancel
2 cor N ’ ) x L§ » =0

Eou. B #ss. [Asn. =0
Studio Console

an outline is not available.

Oitems selacted N

sl 317 : et RRAN ks tiriadl

sl GuyalaL 43l ru Asude-dl - 67



web - Untitled HTML - Aptana Studio 3

M H @S &€ 50 v Bl ) MO | 4B 1 | & = web
S AppEx.. [Lprojec.. 8 © 0 [EstartPage  © =Untitied HTML &3 o5
= & [e v || | <IDOCTYPE html PUBLIC "-//W3C//DTD HTUL 4,01//EN" o B o .

I “http:/rfwws.w3.org/TR/html4sstrict. ded™>
* o Local Filesystem
4+ <html xmlns="http://wew. wl. org/1999/xhtal” lang="en"»
<head>
<sgta hilp-equive"Content-Type™ content="text/html; charset=utf-8= />
<title=my HIML=/title>
<meta names~author” content="glsica” />

</head>
<body=>

i body>]
i <fhiml>

B ou., # #2sa. Dsn. ™0 B cansole i | B glsica@glsica-Hotebookt; - T Problems ® of o fir =0
a = Studio Console
%

@ Writable Smartinsert  Line: 13 Column: 12

syl 3.18 : el RRAA Sw2adu
419 (BlueGriffon)

sl s 2y BuerRld WYSIWYG wsie HTML 3R 8. dl www.bluegriffon.org u:ul
el dGels s usn B, d Wdw, @, wld, WAn ¥ vy well cwwdg wndqa B D,
A0-4A0RQA At A4Sl Al vonanl wal wsls dsuderl @ s sy, A W -2
YAl Wl s welys AR B, eqRgla-l 2ugf 1.6.24) S-2edu 2ugl 3.1940 eafed 8. dul
gl Gulal 59l AR SRl @ A 2l B,

tri - BlueGriffon

File Edit View

“
4
!p

Variable width - {no ARIA rale)

example [Alef.. fexa. .. tri
[ piTe |

MY PERSONAL DETAILS

NAME
SURNAME
E-MaIL
CONTACT I
Wysiwyg | Source
<body> * <dlv #doc) yuH1>  <div Bhd>  <MY>
Get add-ons! S| 100% -

g 3.19 : sgBanl Gudla s Aederell -
WHIA (Amaya)

World Wide Web Consortium (W3C) gl RsRid apu sl 21wy [Figes, slu-ild WYSIWYG
iR AR 8. d-l wzwa HTML/CSS 2R2: ddld sudi 2udl adl 214 ¢d A asl
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XML-suRd [y - AR2: did AsA vy 8. www.w3.org/Amaya 4l A Al 4Gl
s wsy B, Wl 32040 W @ MRd Aol eale B, Aol A ¥ d-w WA va AS

sy &,

Hew - Amaya 11.4.4

<po</p>

187 «<p=EMAIL <input type="text“"> </p>

QO Oa A ]fnnmw’uipti,iDnrumenis,-’Ne-w.hLml j A
" EH 8 = + % d e PRI Y
REGISTRATION FORM —
TEn T f il
NAME | BEEEE
ADDRESS A & EEEE
EMAIL | ¢ B@E
| BEEEEHOE

= v Style
173 <form action="post”>
4 <hl Theme Classic :l
style="text-align:center;margin-left:auto;margin-right:auto; ">REGISTRATION
176 FORM</hl> .-__._.I .__,‘
177 </form>
) Times I's ll_z‘_j
179 <p><label>NAME <input type="text®> </label></p>
8 EEEE
181 <pa</p>
S T EEE 3@
183 «=p>ADDRESS <input type=“text"> </p= ¥ Apply class

J v Special characters

| Misc

> Artributes

Text R

gl 320 : 2uwl Gudla 53 @R g AMAY

TR

L usedl W loRedl veedl W dsudedl @ @A vl s3Il dskube olrlan uedl dd
2312 U 2uels Rl 37 8. dsiuden Uelld Rl 2d Al wel, R wA widaalleq daud:
U wAdal, Fell Gudosdl A« Gualol s Ak, W B AUUARN dafd Wmun B, SR WR
uid (account) €, dl deRued wuels s3I asi B, G2l A Yy wi-iR Az (Internet
Service Providers - ISP) dsiudz w2 »ulRd oouwl Y3l wld 8. aycufs R ) wasl
gl wHlél uel wxy B, W4 Aptana studio, BlueGriffon ¥id Amaya #al yei-yel [uyes,
iRl AoRsin W2 Guaed IDE QA wel uul &0

Relltaiy

1. aadydl dsude w 2 WAL ML @l 8 ?
2. uwdl dnudet 2wyl UBWAHL Ml AvaA F Yesddl wel s-udl

sl Gualal A A Asudzdl 2a-u 69



3. derudz siiqal w2l 8¢ w w2 weud ceufd wldd Qd) ASA ?

4. dsiudel WU Rl aud UGB Rasoet QA s 59 Ad neely oA & ?
5. dcruderl @l auid sl Anaargl wwdd sdl A ?

6. deudedl ulyd w W2 index.htm] An wng ASA ?

7. seesll aalusdivl olsad w2 su RQsen Guasy 8 7

8. 44 wed g ?

9. derude us- (publishing) »ed 4 ?

10. AuR@s W2 Guast Jeais uqAl 2@l A 2,

11, 2nd Rseyniofl Wy Qs wiie 5 :

(1) oA wlad auiRdl Gdte-t daal wd RAma Rl e susdar w2 QA
4 Meeau o4 ® ?

(@) AsrRuse (b) Al ) il @ Css
(2) dnudedl RsuuBani fA-midl s Yel oAl Al ?

(@) <& (b) Neasaa (c) [Auuax (d
(3) asaudeui 3l WRA el ASA ?

(a) 2Ayel, AeiMa (b) 2AyEl, wriiMa
(©) ydl, »wisiPa (d) »yel, iR
(4) DAl su usiRel Ruyag dsiude, e, Gaued, Acl A A dgrild Rdouas-
ui oud 8 ?
() [Aqgd (b) aisll (c) wx @ 4

(5) Aol widAsRA 4 58 & ?
(a) Aol ®) &l () &R @ Asrude

(6) suGx-i sl URL GRRaMl »Ud, cld vdadiil sladl wui widid g 52 8 ?
(@ iy ®) ikm ¥ (©) sy @ was Uy

(7) dsudert alwadl s «UH »uyl AN sAL ASW ?
(a) firsthtml (b) indexhiml (¢) homehtml (d) onehtml
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(8) Gudldlsalrl sl AUS s WadL A o 8 B ?

(a) Integer (b) HIML (¢) Cookie (d) Java
(9) FTPq w3 ~un 3 8 7
(@ File Truncate Protocol (b) File Transfer Process
(c) Fine Tune Protocol (d) File Transfer Protocol
walBis 2etuy

1. sl Gual &3l daudl woudl deruse sieudl
SARAL GudaL s3]l ‘oRdl darud’ [QNa W dsde elridl

sl GuAlal &3 Qarid 2Rop’ Ruy W dsrude el

I A

sl Guilal g3l Vassivl gald MR S-Sl doude eiriel,

sl Gudla s3l uan Al 7
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